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Section 1
Getting Started
By the end of this section you should be able to:
Understand Spreadsheet Principles
Start a Spreadsheet Program
Recognise the Spreadsheet Screen Layout
Use the Ribbon and Quick Access Toolbar
Use Help
Change Preferences
Close a Spreadsheet Program

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then
perform the numbered steps of the Manoeuvres. Complete the Revision
exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 1 - Starting Excel
Park and Read
Excel is an extremely useful Spreadsheet application (or “app”) created
specifically to help in the processing of tabular information, usually numbers.
The spreadsheet stores information in rows (across the screen) and columns
(down the screen), forming a worksheet (the Excel term for a spreadsheet).
Spreadsheets are most commonly used to manipulate figures. They can be
used for accounting, cash flows, budgeting, forecasts, etc. Any job that involves
the use of numbers can be done on a spreadsheet.
The biggest advantage that a spreadsheet has over other methods of
manipulating data is its ability to constantly update figures without the user
having to do any calculations. Once a spreadsheet is set up, its calculations will
always be correct and any changes in data are automatically updated.
Spreadsheets can also take raw data and present it in an attractive way, with
formatted tables and charts.
The steps required to start Excel vary slightly depending on the version of
Windows installed on your computer.

Manoeuvres
1.

Start your computer and log in to Windows.

2.

Find and click the Start button,
or
left corner of the Desktop on the Taskbar.

3.

The Start Menu appears. Click All Programs or All apps at the bottom of
the Start Menu to show a list of available programs.

, found towards the bottom

If you are using Windows 8, a full Start Screen may be shown instead.
All Programs will appear as a downwards facing arrow.

4.

Find and click the entry for the spreadsheet program Excel 2016. You
may need to scroll to find it.

You can also type Excel when the Start Menu is open to search for and start
the program. You may also find a button for it on the Taskbar.

5.

Excel 2016

Excel starts and appears in its own window. Leave the application open
for the next lesson.
9

© CiA Training Ltd 2016

Section 1 Getting Started

ECDL

Driving Lesson 2 - The Excel Screen
Park and Read
When first started, Excel displays a welcome screen showing a selection of
templates that can be used to create new spreadsheets. Any recently opened
files will be listed on the left.

Manoeuvres
1.

Examine the Excel welcome screen. Notice the list of templates that can
be used to create new spreadsheets.

2.

Click Blank workbook. Excel displays a new, blank workbook named
Book1 (as shown in the Title Bar). A workbook is a file that can contain
many worksheets.

3.

The Excel screen will be similar to the screenshot below. Check the
captions and identify the parts on the screen. Sheet1 is displayed.
Quick Access Toolbar

Title Bar

File tab

Ribbon

Status Bar

4.

The Title Bar is the top line of the Excel screen. It shows the application
and the name of the workbook that is on the screen. Identify the Title Bar.

5.

The name of the current workbook is Book1 or similar. Check this in the
Title Bar.

© CiA Training Ltd 2016
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Driving Lesson 2 - Continued
6.

At the top left of the screen the first tab on the Ribbon is the File tab,
. This displays a list of basic program functions such as; Open,
Save, Print and Close.

7.

Immediately above this button is the Quick Access Toolbar.

8.

By default this contains three main buttons, Save, Undo and Redo. More
buttons can be added.

9.

Under the Quick Access Toolbar is an area called the Ribbon. This
consists of a range of tabs containing buttons within groups (which you
will learn more about in the next lesson).

10. The buttons are used to select an action or basic feature. Move the cursor
over any button but do not click. Read the ToolTip that appears which
gives the name of that button and a small description, e.g. Italic in the
Font group.

11. The Status Bar runs along the bottom of the window. This displays
messages as tasks are performed. Check that the current message, at the
left, states Ready.

12. The right side of the Status Bar contains View buttons and a Zoom
slider.

13. Leave the application open for the next lesson.

Excel 2016
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Driving Lesson 3 - The Ribbon
Park and Read
Excel 2016 has a Ribbon which is displayed at the top of the application
window. The Ribbon contains buttons and drop-down lists to control the
operation of Excel. The Ribbon is divided into a series of Tabs, each one of
which has a set of controls specific to a certain function or process. On each
tab, the controls are further divided into separate Groups of connected
functions.
Some tabs can be selected manually, whereas some only appear when certain
operations are active (for example, only when a Chart is active will three
CHART TOOLS tabs be displayed).

Manoeuvres
1.

On the Ribbon, the Home tab should currently be selected. Other basic
tabs are available.

Part of the Ribbon displaying the Home tab

Any buttons displayed in pale grey are called ghosted and are not available to
be selected at present.

2.

Notice how the buttons on the Ribbon are divided into Groups
(Clipboard, Font, Alignment, etc.).

The display of buttons on the Ribbon is dynamic. That is, it will change
according to how much space there is available. If the window is not maximised
or the screen resolution is anything other than 1024 x 768, the Ribbon will not
always appear exactly as shown in this guide.

3.

Some buttons produce immediate effects like the Bold, Italic and
Underline buttons in the Font group.

4.

Buttons with a drop-down arrow lead to further options. Click the
Find & Select button which is available in the Editing group. A
list of further options is displayed.

© CiA Training Ltd 2016
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Driving Lesson 3 - Continued
5.

Some options will display a dialog box which needs data to be entered.
Click the first option, Find, and the Find and Replace dialog box is
displayed.

6.

Click the Close button on the dialog box to remove it.

7.

Some groups have a dialog box launcher button,
group name, e.g. the Font group,

, to the right of the
.

8.

Click the Font dialog box launcher to display the Format Cells dialog box.

9.

This is a tabbed dialog box; each tab at the top (e.g. Number, Alignment,
Font) can be clicked to see a different set of options. Try it. When you are
finished, click Cancel to close the dialog box.

10. Display the other basic tabs one at a time: Insert, Page Layout,
Formulas, Data, Review and View to see which other commands are
available.
There may be a DEVELOPER tab displayed, used for controlling macros. This
tab is usually not displayed by default.

11. Select the Home tab again.

Excel 2016
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Driving Lesson 4 - Quick Access Toolbar
Park and Read
Most commands in Excel are accessed via the Ribbon. Above the Ribbon is
the Quick Access Toolbar which contains a few popular command buttons. By
default this toolbar has three buttons: Save, Undo and Redo. This toolbar can
be customised by adding further buttons.

Manoeuvres
1.

Locate the Quick Access Toolbar at the top left corner of the window.

2.

Point at each button and read its ToolTip. There have been no actions
performed yet, so the last two buttons are ghosted (but they still have
ToolTips).

3.

To the right of the buttons is the Customize Quick Access Toolbar
button,
. Click the button to display a menu. You can add any of the
buttons shown by simply clicking them.

4.

To add commands not shown, select
More Commands. This displays Excel
Options, which is covered later in this
guide. For now, click Cancel to close
Excel Options.

5.

Minimize the Ribbon by clicking the
,
Ribbon Display Options button,
which is located at the top right of the
screen. Select the Show Tabs option.

6.

The Ribbon is hidden with only the tabs
displayed. The ribbon is accessed again
by clicking the tabs. Click Home and the
complete Home tab is displayed from
which a selection can be made.

7.

Click on a cell in the worksheet window.
The Ribbon is hidden again.

8.

To restore the Ribbon, click the Ribbon Display Options button again,
and select Show Tabs and Commands. The Ribbon is displayed
normally again.

The Ribbon can also be minimized by right clicking on it and selecting the
Collapse the Ribbon option. To restore the Ribbon right click on any tab and
uncheck Collapse the Ribbon. There is also a Collapse the Ribbon button at
the right end of the Ribbon,
.

© CiA Training Ltd 2016
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Driving Lesson 5 - The Worksheet Window
Park and Read
Spreadsheets help in the processing of numbers. They store information
arranged in rows (across the screen) and columns (down the screen). A cell
is the intersection of a row and column. It is good practice for each filled cell to
contain only a single element of data.
All the cells form a worksheet (the Excel term for a spreadsheet). Several
worksheets are bound together and called a workbook.

Manoeuvres
1.

Each cell is identified by a column letter and row number which form an
intersection, e.g. the cell formed where column D and row 8 meet is
known as cell D8. Move the mouse pointer to cell B3 and click. The
Current or Active cell is now B3. It has a dark green border.

Active Cell
Reference
Formula Bar

Active Cell

Column
Heading

Scroll Bars

Row Border
Sheet Names

2.

Look for the Active Cell Reference, which is shown in the Name Box at
the left of the Formula Bar. It displays B3.

3.

Click in cell C6. The Active Cell Reference now shows C6. These letters
and numbers are shown highlighted in the Row and Column Headings
on the worksheet. C6 is now the Current or Active cell.

4.

The active cell can be moved using various key presses. Press the right
cursor key →. The active cell moves right into cell D6.

5.

Press the down cursor ↓ to move into cell D7. Press the left cursor ← to
move into C7.

6.

Press the up cursor ↑ . The active cell should now be C6 again.

Excel 2016
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Driving Lesson 6 - Moving Around
Park and Read
A worksheet is very large. The arrow keys are used for moving small distances.
Other keys are used to move bigger distances.

Manoeuvres
1.

Use the right cursor key → repeatedly to move to the column after Z. The
alphabet is used again with A in front, i.e. AA AB …, then BA, BB …, etc.

2.

The <End> key followed by an arrow key moves to the edge of the
worksheet when empty. To move to the last column press <End> then the
right arrow key →. The last column is XFD (column 16384).

3.

Press the <Home> key. This always returns the active cell to column A on
the same row.

4.

Click on cell D3. Press <End> followed by the → key to move to XFD3.

5.

Press the <Home> key to return to cell A3.

6.

Press <End> then the Down cursor key ↓. The active cell moves down to
the last row, 1048576.

7.

Press <Ctrl Home> (hold down the Control key and press the Home key)
to move back to cell A1. The key press <Ctrl Home> always moves the
active cell back to A1.

8.

Click on a cell in the centre of the screen and press <Ctrl Home> to move
to A1 again.

There are other key presses and mouse actions that also move the active cell
around a worksheet. These are covered later when a workbook is opened that
has cell contents added.

© CiA Training Ltd 2016
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Formulas
By the end of this section you should be able to:
Enter Basic Formulas
Use AutoSum
Check Formulas
Check Spelling

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then
perform the numbered steps of the Manoeuvres. Complete the Revision
exercise(s) at the end of the section to test your knowledge.

Excel 2016
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Driving Lesson 26 - Formulas
Park and Read
A calculation in Excel is called a Formula.
All formulas begin with an equals = sign, followed by the calculation. The
calculation consists of cell references or numbers separated by a mathematical
symbol (+ add, - subtract, * multiply, / divide), e.g. =A1+A2.
Formulas are used to calculate answers from numbers that are entered onto a
sheet. To create formulas properly you should enter the cell references of those
cells used in the calculation rather than just typing in the numbers. This means
that if the numbers in these cells are changed later, the formulas will be
recalculated and will still be correct.

Manoeuvres
1.

Start a new workbook, select cell B2 and type in 66. Move to cell B3 and
type 34.

2.

Move to cell B4 and enter a formula to add the contents of cells B2 and
B3 by typing =b2+b3. Press <Enter>. Click in cell B4 and note the cell
display of 100 and the formula in the Formula Bar converts to uppercase.

3.

In B6 enter the formula which divides B2 by B3: =b2/b3. Press <Enter>
to confirm the entry and the answer is shown as 1.941176.

4.

Move to cell A8 and enter the following numbers (use the right directional
arrow to complete each entry) into these cells: A8 35, B8 23, C8 56,
D8 99, E8 55.
Move to cell F8 and type in this formula =a8+b8+c8+d8+e8 and press
<Enter>. The answer should be 268.

5.
6.

Move back to cell F8 and enter an = sign to begin the formula. Select cell
A8 and it appears in the Formula Bar. Type in the + symbol, then select
cell B8. Continue entering the + symbol and selecting the other cells until
the formula =A8+B8+C8+D8+E8 is complete again. Note the different
coloured cell borders that match the cell references. Press <Enter>.

7.

Move to cell B8 and change the value to 43 by over-typing the original
value. Press <Enter> and the formula in cell F8 is instantly recalculated. A
spreadsheet containing formulas is never out of date.

8.

Leave the workbook open for the next lesson.

© CiA Training Ltd 2016

42

Excel 2016

ECDL

Section 4 Formulas

Driving Lesson 27 - Brackets
Park and Read
When more than one symbol is used in a formula, then the order becomes
important, e.g. A1+A2/A3. Excel performs calculations in this order: Brackets
over Division, Multiplication, Addition and finally Subtraction (the BODMAS
theory).

Manoeuvres
1.

Click the New Sheet button,
, to the right of Sheet1 (there can be
more than one worksheet in each workbook, clicking on a Sheet tab
displays that sheet).

2.

Create the following small worksheet.

3.

To calculate the profit, click on cell B5 and type the formula =b2-b3*b4
and press <Enter> to complete the formula.

4.

The answer is given as -14 because multiplication is carried out before the
subtraction (according to the BODMAS theory).

5.

Click on cell B5 to re-enter the formula, but this time add brackets around
the subtraction part of the formula =(b2-b3)*b4. The old formula is
replaced by the new.

6.

Check the answer displayed. Profit per item 10-6, which is 4, multiplied by
the number sold, 4, giving 16.

7.

Close the workbook without saving the changes.

Brackets are added to force Excel to perform calculations in a different order.
The calculation in the brackets will be performed first no matter what
mathematical operation is used.
Excel 2016
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Driving Lesson 28 - AutoSum
Park and Read
The most common mathematical operation is addition. This calculation can
been simplified by the use of a Function called AutoSum. AutoSum adds the
contents of cells automatically.
AutoSum,
, can be found on two Ribbon tabs: Home and Formulas. The
Home tab has a button in the Editing group and on the Formulas tab there is
an AutoSum button in the Function Library group.

Manoeuvres
1.

Start a new workbook and enter the following numbers into the cells
shown:

2.

Select cell B5 and click the AutoSum button,
, on the
Formulas tab (within the Function Library group). The AutoSum feature
automatically finds numbers to add.

3.

Press <Enter> to complete the entry. The answer should be 9. Repeat
this in cells C5 and D5.

4.

AutoSum also adds cells across. Select cell E2 and click the AutoSum
button. Press <Enter> to complete the entry. Repeat this in E3 and E4.

5.

Close the workbook without saving.

6.

Open the workbook Sum.

7.

Select cell B7. The three numbers above need to be added together to
find the total number of apples sold in the three month period.

© CiA Training Ltd 2016
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Driving Lesson 28 - Continued
8.

Click the AutoSum button,

9.

Finish the formula by pressing <Enter> to sum the numbers above. The
answer should be 129.

10. Move to cell E4 and click the AutoSum button,

. The
January figures are selected, so press <Enter> to complete the formula.
The answer should be 100.

11. Use AutoSum to calculate the totals in cells, C7, D7 and E5.
AutoSum adds the cells above or left depending on where nearby figures are
located. If AutoSum has figures in both directions it will sum the cells above by
default.

12. Use AutoSum to calculate the total in cell E6. After clicking
you will need to click and drag with the mouse from cell B6 to cell D6 to
select the range B6:D6, as the cells above E6 are selected by default.
Complete the formula by pressing <Enter>.

13. Calculate the grand total in cell E7 (adding cells to the left or above
displays the same result, so the default range will be correct).

14. The answer 317 appears.
15. Save the workbook as Sum Complete and close it.

Excel 2016
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Driving Lesson 29 - Checking for Errors
Park and Read
A worksheet is of little use if one formula within it is incorrect. Correct spelling is
also important. It is vital that workbooks that are to be distributed are checked
so that the worksheets contain no text or formula errors.
Formulas must be checked to see that they refer to the correct cells. Some
formulas produce #MESSAGE denoting an error. Types of errors you need to
recognise are:
#DIV/0!
Division by zero
#REF!
Cell reference is not valid
#NAME?
Does not recognise text in a formula
You may also come across the following errors:
#NULL!
The two areas specified do not intersect
#VALUE!
The wrong argument used
#NUM!
Error with number in formula
#N/A
The value used in the formula is not available
######
The result is too long to fit into the cell
Mistakes can be checked either visually or, better still, using Excel’s spell
checking facility.

Manoeuvres
1.

Start a new workbook.

2.

In cell B3 type 6, in cell D3 type 8, in cell B5 type 10 and in cell D5 enter
the formula =b3+b5-d3. Press <Enter>.

3.

Double click on cell D5 to check the formula.

Excel uses a different colour for each part of the formula.

4.

If your screen matches the above diagram then it is correct. Press
<Enter>.

5.

Close the workbook without saving.

© CiA Training Ltd 2016
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Driving Lesson 29 - Continued
6.

Open the workbook Formulas. Check the formulas on row 6 and cell B12
for errors by double clicking on each cell. Remember to press <Esc> to
cancel after checking.

7.

There is an error in cell D6 – it contains a value, not a formula. Enter a
formula in cell D6 to multiply the two numbers above, =d4*d5.

8.

Click on cell E5 and enter 0. The cell E6 displays the #DIV/0! error
message, division by zero. Click on cell E6 and display the Formulas tab.

9.

Click the Error Checking button,
in the Formula Auditing group.
The error is described in the Error Checking dialog box. Read the
information. Experiment with the options and then close It.

10. Close the workbook without saving.
11. Open the workbook Spell. With A1 the active cell, click the
Review tab and click the Spelling button, in the Proofing group.

12. The Spelling dialog box will show the first mistake. A1 is highlighted. The
cell should read House. The Suggestions box displays House, so click
the Change button to correct the error.

13. The Spelling dialog box finds the next mistake in cell A4. The cell should
read Other, the h has been missed out. Click on Other in the
Suggestions list and then click the Change button. Correct the other
mistakes on the worksheet.
Text can be entered directly into the Not in Dictionary box, if the required word
is not in the Suggestions list, or, the error can be ignored.

14. When finished spell checking, click OK.
15. Close the workbook without saving.
Excel 2016
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Driving Lesson 30 - Revision
Park and Read
At the end of every section you get the chance to complete one or more
revision exercises to develop your skills and prepare you for your ECDL
certification test. You should aim to complete the following steps without
referring back to the previous lessons.

Manoeuvres
1.

On a blank worksheet enter the numbers in the cells to match below.

2.

Click in cell E9. AutoSum is to be used. Will it sum the column or the
row?

3.

Click the AutoSum button on the Home tab. Press <Enter>. What is the
answer?

4.

Delete the answer in cell E9 by clicking in cell E9 and pressing the
<Delete> key. You now need to sum the row of numbers. Click the
AutoSum button, then click and drag from A9 to D9 or D9 to A9. Press
<Enter> to complete the formula. What is the answer?

5.

Click on cell E3 and delete the contents.

6.

Delete the answer in E9.

7.

With cell E9 active click the AutoSum button. You need to add all the
column, click and drag the range E1:E8, press <Enter>. What is the
answer?

8.

Close the workbook without saving it.

Sample answers can be found at the back of the guide.
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Driving Lesson 31 - Revision
Manoeuvres
1.

Start a new workbook. The worksheet below contains data on boxes of
fruit. Insert the following information in the cells indicated.

2.

Use AutoSum to sum the sales for each fruit (in Row 7) and for each
month (in Column E). Calculate a grand total in cell E7 (using either the
column totals to the left or the row totals above).

3.

The Sell Price of the three fruits are 9, 11 and 13 for the apples, pears
and oranges respectively. Enter this information.

4.

The Income row should contain formulas that multiply the Total by the
Sell Price. Complete the three cells.

5.

The buying prices of the three fruits are 5, 6 and 7 for the apples, pears
and oranges respectively. Enter this information.

6.

The Profit is a more complicated formula containing brackets. Work out
the profit for one box of fruit using subtraction in brackets and multiply by
the total number of boxes sold. The result in cell B11 should be 96.

7.

Create similar formulas to calculate the profit for the pears and oranges.

8.

Use AutoSum to calculate the total income in cell E9 and total profit in
cell E11. This should be 377.

9.

Check all the formulas by double clicking on each in turn and then save
the completed workbook as Fruit Sales and close it.

Now complete the Record of Achievement Matrix at the back of the guide.
You should only move on when confident with the topics and features
described in this section.
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